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Overview

Products Supported

This Installation Guide provides device driver installation and configuration 
procedures for the following operating systems:
• Windows 7
• Windows Server 2008
• Windows Vista
• Windows Server 2003
• Windows XP
The following products are supported by this device driver:
• RocketModem Universal PCI (RocketModem IV)
• RocketPort Universal PCI
• RocketPort Universal PCI SMPTE
• RocketPort Plus Universal PCI
• RocketPort Plus Universal PCI 422
In the remainder of this guide, the products are merely referred to as RocketPort/
RocketModem.

How to Use this Guide

Use this guide to install and configure the device driver for Windows for the 
RocketPort and RocketModem Universal PCI families. It provides the following 
procedures and information:
• Initial device driver installation (Initial Driver Installation on Page 7)
• Updating the existing device driver (Updating the Driver on Page 13)
• Adding another adapter (Adding an Adapter (Existing Installation) on Page 

19)
• Configuring ports (Configuring COM Port Properties on Page 21)
• Configuring device properties (Configuring Device Properties on Page 25)
• RocketPort/RocketModem configuration screens (Configuration Screens on 

Page 27)
• Removing the RocketPort/RocketModem device driver (Removing the Adapter 

and Driver on Page 33)
• Troubleshooting and testing ports (Troubleshooting and Technical Support on 

Page 37)
• Setting up non-plug and play modems and printers (Configuring Non-Plug 

and Play Devices (Windows XP and Windows Server 2003) on Page 41)
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 Overview 
Downloading the Latest Software and User Guides

You can use the CD shipped with your product or the following table to locate the 
latest version of the software and documentation for the RocketPort/RocketModem 
from the Comtrol ftp site.

 Files Download Pages

R
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M
od

em
IV

Device Drivers ftp://ftp.comtrol.com/html/RM4_drivers.htm

Diagnostics 
Comtrol Utility

ftp://ftp.comtrol.com/html/RM4_Diag.htm

User Guides ftp://ftp.comtrol.com/html/RM4_Docs.htm
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I Device Driver ftp://ftp.comtrol.com/html/RPuPCI_Drivers.htm

Diagnostics 
Comtrol Utility

ftp://ftp.comtrol.com/html/RPuPCI_Diag.htm

User Guides ftp://ftp.comtrol.com/html/RPuPCI_Docs.htm
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Device Driver ftp://ftp.comtrol.com/html/RPuPCIsmpte.htm

Diagnostics
Comtrol  Utility

ftp://ftp.comtrol.com/html/RPuPCIsmpte_Diag.htm

User Guides ftp://ftp.comtrol.com/html/RPuPCIsmpte_Docs.htm
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C

I Device Driver ftp://ftp.comtrol.com/html/RPuPCIplus_Drivers.htm

Diagnostics 
Comtrol Utility

ftp://ftp.comtrol.com/html/RPuPCIplus_Diag.htm

User Guides ftp://ftp.comtrol.com/html/RPuPCIplus_Docs.htm
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P
C

I Device Driver ftp://ftp.comtrol.com/html/RPuPCIplus422_Drivers.htm

Diagnostics 
Comtrol Utility

ftp://ftp.comtrol.com/html/RPuPCIplus422_Diag.htm

User Guides ftp://ftp.comtrol.com/html/RPuPCIplus422_Docs.htm
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Initial Driver Installation

Use the following procedure to install the RocketPort/RocketModem device driver 
for Windows.
Note: Close any applications that are using serial ports before the device driver 

installation.
1. Locate the latest driver assembly (.msi) and copy it to a location that is 

available to the host PC.
You can use one of the following methods to locate the device driver:
• Download the latest device driver using the appropriate link in the 

Downloading the Latest Software and User Guides subsection on Page 6.
• The Software and Documentation CD contains all of the files for 

installation, configuration, and troubleshooting. The CD also provides 
download links to the Comtrol ftp site to locate the latest files.

2. Install the adapter and connect the interface. If you need detailed hardware 
installation procedures, see Downloading the Latest Software and User Guides 
on Page 6 to locate the User Guide for your RocketPort/RocketModem. 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The RocketPort/
RocketModem default port setting is RS-232.

3. Click Cancel if a Found New Hardware message appears.

4. Start the installation by executing the RocketPort_Windows_x.xx.msi file, 
where x.xx is the driver assembly version.

Caution
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 Initial Driver Installation 
5. Click Next to start the installation process.

6. Optionally, enter a different location to install the driver files.
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 Initial Driver Installation 
7. Click Install.

8. Click Finish.

Note: Leave the Launch RocketPort/RocketModem Driver Installation box 
checked.

If you do not check this box, you can use the shortcut under the Start button at: 
Programs/Comtrol/RocketPort/Driver Installation Wizard.
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 Initial Driver Installation 
9. Click Next to install the driver.

10. Click Install and Next.
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 Initial Driver Installation 
11. Click Next to start the driver installation.

12. Click Proceed.

13. Click Ok to close the Driver Installer Notice.
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 Initial Driver Installation 
14. Click Close to exit the wizard.

15. Go to Configuring COM Port Properties on Page 21 to configure the COM port 
properties.

16. If necessary, go to Configuring Device Properties on Page 25 to set up advanced 
device properties such as: changing the device name and starting COM port 
number.

After driver installation and configuration, connect the serial devices to the ports. 
For information about the RocketPort/RocketModem connectors, refer to the 
appropriate User Guide (Page 6) for your RocketPort/RocketModem model.
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Updating the Driver

Use this procedure to update the RocketPort/RocketModemdevice driver after 
initial installation.
1. Locate the latest driver assembly (Page 6) and copy it to a location that is 

available to the host PC.
2. Start the update by executing the RocketPort_Windows_x.xx.msi file, where x.xx 

is the driver assembly version.
3. Click Next to start the Installation Setup Wizard.
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 Updating the Driver 
4. Optionally, enter a different location to install the latest driver files.

5. Click Install.
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 Updating the Driver 
6. Click Finish.

Note: Leave the Launch RocketPort/RocketModem Driver Installation box 
checked.

If you do not check this box, you can use the shortcut under the Start button at: 
Programs/Comtrol/RocketPort/Driver Installation Wizard.

7. Click Next to update the driver.
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 Updating the Driver 
8. Click Update and Next.

9. Click Next to update the driver.
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 Updating the Driver 
10. Click Proceed.

11. Click Close.

12. Go to Configuring COM Port Properties on Page 21 to configure the COM port 
properties.

13. If necessary, go to Configuring Device Properties on Page 25 to set up advanced 
device properties such as: changing the device name and starting COM port 
number.

After driver installation and configuration, connect the serial devices to the ports. 
For information about the RocketPort/RocketModem connectors, refer to the 
appropriate User Guide (Page 6) for your RocketPort/RocketModem model.
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Adding an Adapter (Existing 
Installation)

Use the following procedure to add an adapter to an existing RocketPort/
RocketModem installation.
1. Install the adapter and connect the interface. If you need hardware 

installation procedures, see Downloading the Latest Software and User Guides 
on Page 6). 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The RocketPort/
RocketModem default port setting is RS-232.

2. Click Cancel if a Found New Hardware message appears.

3. From the Start button, click Programs/Comtrol/RocketPort/Driver Installation 
Wizard.

Caution
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 Adding an Adapter (Existing Installation) 
4. Click Next to start the Comtrol Driver Installation Wizard.

5. Click Install and Next.

6. Click Next and follow the Installation Wizard. Refer to Step 11 on Page 11, for 
the remainder of the installation steps if needed.
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Configuring COM Port Properties

Port Configuration Overview

Advanced and standard COM port configuration procedures are discussed in this 
section. Each configuration parameter is discussed in detail in the Configuration 
Screens section on Page 27.
• Advanced COM port configuration using the Port Setup tab (below) for the 

RocketPort/RocketModem port. You may need to change one or more of the 
default values to match your serial device. 

• Standard COM port configuration using the Port Settings tab (Page 24) if you 
need to change any of the default COM port parameters.

If you want to change the starting COM port number on the RocketPort/
RocketModem, see Configuring Device Properties on Page 25.

Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The driver default port setting 
is RS-232.

COM Port Properties Field Default Acceptable Values

Override and lock baud rate to None

300, 600, 1200, 1800, 
2400, 3600, 4800, 7200, 
9600, 14400, 19200, 
38400, 57600, 115200, 
230400, 460800, or 
921600

Timeout on transmit data on 
port close 0 seconds 1, 6, 30, 60, and 240 sec

Map CD to DSR Disabled N/A

Map 2 stop bits to 1 Disabled N/A

Wait on physical transmission 
before completing write Disabled N/A

Emulate modem hardware 
RING signal Disabled N/A

Block PnP search for attached 
serial device Disabled N/A

Clone Disabled N/A

Caution
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 Configuring COM Port Properties 
Advanced COM Port Configuration

Use the following procedure to change COM port properties on a RocketPort/
RocketModem port or ports.
1. Access the Main Setup tab for the RocketPort/RocketModem using the Device 

Manager.
• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 

then highlight the Device Manager.
• Windows Server 2008 R2: Click Start, right-click Computer, and then click 

Properties.
• Windows Server 2003: Right-click My Computer, click Manage, and then 

click the Device Manager button.
• Windows XP

Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Expand the Multi-port serial adapters entry, right-click the RocketPort/
RocketModem you want to configure, and then click Properties.
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 Configuring COM Port Properties 
3. Select the Main Setup tab, highlight the COM port you want to configure, and 
then click Properties.

4. Enable the features (Page 27) you want to use, such as setting the appropriate 
communications mode for your serial device.

5. Click OK after configuring this port or click the Clone check box to set all of the 
ports on this RocketPort/RocketModem to these characteristics.
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 Configuring COM Port Properties 
Standard COM Port Configuration

Use the appropriate procedure for your operating system if your application does 
not set COM port properties. 
If the application sets COM port properties, those settings take precedence over 
the standard COM port settings. The exception to this guideline is if you use the 
Override and Lock Baud Rate advanced COM port setting (Page 28).
Use the following procedure to change standard COM port parameters default 
values (Page 29).
1. Access the Device Manager.

• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 
then highlight the Device Manager.

• Windows Server 2008 R2: Click Start, right-click Computer, and then click 
Properties.

• Windows Server 2003: Right-click My Computer, click Manage, and then 
click the Device Manager button.

• Windows XP
Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Double-click Ports (COM & LPT) to expand 
the view.
Note: RocketPort/RocketModem are 

displayed as Comtrol RocketPort 
ports. in the Device Manager.

3. Double-click the RocketPort/RocketModem 
COM port for which you want to change 
port parameters.

4. Click the Port Settings tab.
5. Make any necessary changes for 

the port.
6. Repeat this process for each port 

you that you need to change the 
COM port parameters.
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Configuring Device Properties

You may want to change the device Name or the Starting COM Port number on the 
RocketPort/RocketModem. 
To change RocketPort/RocketModem or COM port configuration, you need to 
access the Properties page for that RocketPort/RocketModem. 
Note: You must be logged in with Administrator privileges to access the Device 

Manager.

1. Access the Properties page for the RocketPort/RocketModem using the Device 
Manager.
• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 

then highlight the Device Manager.
• Windows Server 2008 R2: Click Start, right-click Computer, and then click 

Properties.
• Windows Server 2003: Right-click My Computer, click Manage, and then 

click the Device Manager button.
• Windows XP

Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Expand the Multi-port serial adapters entry, right-click the RocketPort/
RocketModem you want to configure, and then click Properties.

3. Click the Main Setup tab.
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 Configuring Device Properties 
4. Highlight RocketPort/RocketModem device name and then click Properties. 

5. Make the desired changes.
For example:
• Change the device name.

The name that you assign 
is not saved until you click 
OK to exit the Main Setup 
tab. The new device name 
may not be present itself 
until the Device Manager is 
closed and reopened. 

• Click the starting COM 
port number in the drop list 
for this RocketPort/
RocketModem.

6. After making your changes, 
click OK and follow any other 
driver prompts.
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Configuration Screens

Use the Device Manager to access the RocketPort/RocketModem driver Main 
Setup tab, if you need to change configuration of the default (Page 29) advanced 
COM port settings.
Use the Device Properties dialog to rename the RocketPort/RocketModem, or 
change the starting COM port number.

Main Setup Tab

The Main Setup tab for the 
RocketPort/RocketModem is 
accessed through the Device 
Manager.
1. Access the Device Manager in 

your Windows operating system.
• Windows 7 and Windows 

Vista: Right-click Computer, 
click Manage, and then 
highlight the Device Manager.

• Windows Server 2008 R2: 
Click Start, right-click 
Computer, and then click 
Properties.

• Windows Server 2003: Right-
click My Computer, click 
Manage, and then click the 
Device Manager button.

• Windows XP
Not logged into a domain 
controller: Right-click My Computer, click Manage, and then highlight the 
Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Click the Main Setup tab to access the RocketPort/RocketModem configuration 
screens:
• COM Port Properties for a COM port configuration. Highlight the COM port 

that you want to configure and then click Properties.
• Device Properties to change the name of the RocketPort/RocketModem or 

the starting COM port number. 
Highlight the RocketPort/RocketModem adapter that you want to configure 
and then click Properties.
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 Configuration Screens 
Port Setup Tab

The Port Setup tab is used to configure advanced COM port properties. See 
Advanced COM Port Configuration on Page 22 for configuration procedures.

After configuring a port, you can use the Clone feature to set all of the ports on the 
RocketPort/RocketModem to these characteristics.

COM Properties Description

Override and lock 
baud rate to

This option allows you to lock selected ports.
You can select a value from the drop list or enter an 
appropriate value from the following standard baud rates: 
300, 600, 1200, 1800, 2400, 3600, 4800, 7200, 9600, 14400, 
19200, 38400, 57600, 115200, 230400, 460800, or 921600. 
• RocketModem IV models support from 300 to 115.2Kbps
• RocketPort Universal PCI Quad/Octacable and 4J/8J 

models support from  300 to 460.8Kbps.
• RocketPort Universal PCI 8/16/32-port models with an 

interface box support from 200 to 230.4Kbps.
• RocketPort Plus Universal PCI models from 200 to 

921.6Kbps
• RocketPort Plus Universal PCI 422 models from 200 to 

921.6Kbps
• RocketPort Universal PCI SMPTE models from 200 to 

921.6Kbps
After locking a baud rate, no matter what baud rate is 
selected in a host application, the actual rate used is the rate 
specified here.
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 Configuration Screens 
Timeout on transmit 
data on port close

This option allows you to select the length of time to wait for 
data to clear the transmit buffer after a host application has 
closed the port. This is typically used with serial devices 
such as printers, to give the data sufficient time to flush 
through the system.

Map CD to DSR

This option is used in installations where there is no 
connection to the port’s DSR input.
Click this check box to cause the CD input to appear as DSR 
to the host application, and to perform hardware 
handshaking with CD rather than DSR.

Map 2 stop bits to 1

If your application is hard-coded to use two stop bits and you 
receive framing errors, click this check box to map 2 stop bits 
to 1 bit. 
Leave this check box blank to enable stop bits to pass 
through unchanged.

Wait on physical 
transmission before 
completing write

This option forces all write packets to wait until the transmit 
data has physically completed the transmission before 
returning completion to the host application. 
The default mode (check box not clicked) is to buffer the data 
in the transmit hardware buffer, and return completion as 
soon as the packet is in the buffer.

Emulate modem 
hardware RING 
signal

Click this check box to emulate the ring indicator signal. 
If this box is checked and the port receives a RING signal (or 
an alternate code, as defined in the AT command set for the 
modem), it sends an RI signal to the communications 
application.

Block PnP search for 
attached serial device

This option disables plug and play from searching for a 
device attached to the serial port.
For example, data received during device discovery on a 
device is assumed to be a mouse to plug and play.

Defaults

Click this to return to the driver default values.
• Override and lock baud rate to = None
• Timeout on transmit data on port close = 0
• Map CD to DSR = Disabled
• Map 2 stop bits to 1 = Disabled
• Wait on physical transmission before completing write = 

Disabled
• Emulate modem hardware RING signal = Disabled
• Block PnP search for attached serial device = Disabled
• Clone = Disabled

Clone: Apply all the 
settings to all ports

If this check box is not clicked, changes apply to the selected 
port only. 
If this check box is clicked, changes apply to all ports on this 
board.

COM Properties Description
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 Configuration Screens 
Device Properties Screen

You can change the default device 
name and starting COM port with 
the Device Properties screen. See 
Configuring Device Properties on 
Page 25 for configuration 
procedures. 
• Name: The Add New 

Hardware Wizard assigns a 
default name to each adapter. 
Use this field to enter a more 
descriptive name. The name 
that you assign is not saved 
until you click OK to exit the 
Main Setup tab. The new 
device name may not be 
present itself until the Device 
Manager is closed and 
reopened.

• Starting COM Port: You can 
change the starting COM port 
number in the drop list for this 
RocketPort/RocketModem.
In addition, you can use Starting COM Port to set nonsequential starting COM 
port numbers for each adapter, thus leaving gaps in the COM port numbering 
sequence.
Note: When you change the starting COM port number, the driver assigns that 

COM port to the first port on this RocketPort/RocketModem and all 
other port numbers follow in sequence. Do not overlap COM port 
numbers between devices or other RocketPort/RocketModem adapters 
because if you do so, the overlapping ports are disabled.

Port Name  - COM 
name

You may change individual COM names to leave gaps in 
COM name sequences or change the order of the COM 
names. You should reboot the server or Disable and then 
Enable the driver in the Devcie Manager after you change 
COM names.
If you want to renumber all of the ports sequencially, you can 
use the Device Properties screen to change the starting COM 
port number. See Device Properties Screen on Page 30 for 
more information.

COM Properties Description
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 Configuration Screens 
Options Tab

The Options tab contains the 
following options.

Option Description

Verbose 
Event Log

Select this check box to 
cause longer messages 
to be sent to the 
Windows Event Log. 
This added 
information can be 
useful when debugging 
communications and 
configuration 
problems.

Scan Rate Use this droplist to set 
the driver servicing 
rate. As a general rule 
this is changed only if 
you are driving ports 
at rates in excess of 
230.4 Kbps. 
For example, if you are 
using a RocketPort 
Universal PCI 
OctaCable running at 
460.8 Kbps, select 4 
ms. If you are running 
a RocketPort Plus 
Universal PCI at 921.6 
Kbps, select 2 ms.
Note: The faster the 

scan rate (lower 
number), the 
higher the load 
on the system 
processor.

RS-485 You must have an 
external RS-232/485 
convertor attached to 
the RocketPort 
adapter port. 
Otherwise, leave this 
box blank.
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 Configuration Screens 
Port Settings Tab

The Port Settings tab for each RocketPort/RocketModem COM port is accessed 
through the Device Manager under the Ports (COM & LPT) entry.
Use the Port Settings tab to configure standard COM port parameters. 

COM Port 
Parameters Description

Bits per second
Use this drop list to select the default application baud rate for 
the data to be transmitted through this port to the serial 
device. The default is 9600.

Data bits If necessary, change the number of data bits to match the serial 
device connected to this port. The default is 8.

Parity If necessary, change parity to match the error checking used 
with the serial device attached to this port. The default is None.

Stop bits If necessary, change the stop bits to match the stop bits used by 
the serial device connected to this port. The default is 1.

Flow control

It is recommended that flow control be used to prevent data 
buffer overflow conditions.
Hardware flow control (RTS/CTS) is best because most modems 
default to hardware flow control.
Software (Xon/Xoff) flow control is used mostly by dot matrix 
printers and terminals where high data throughput is not 
critical.
The default is None.
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Removing the Adapter and Driver

Use the following procedure to remove the RocketPort/RocketModem device driver.
1. From the Start button, click Programs/Comtrol/RocketPort/Driver Installation 

Wizard.

2. Click Next to start the Comtrol Driver Installation Wizard.
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3. Click Remove All and Next.

4. Click Next to remove the driver.
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 Removing the Adapter and Driver 
5. Click Proceed to continue the driver removal process.

6. Click OK.

7. Click Close.

8. Shutdown the system and remove the RocketPort/RocketModem adapter.
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 Removing the Adapter and Driver 
9. If you want to completely remove the .msi driver assembly, perform the 
following steps:
a. Delete any copies of the RocketPort_Windows_x.xx.msi file residing on the 

system.
b. Delete the driver and devices using the Add/Remove Programs control 

panel:
- Open the Control Panel and click Add or Remove Programs.

- Highlight RocketPort/RocketModem Driver Installation and click Remove. 
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Troubleshooting and Technical Support

Troubleshooting Checklist

If you are having trouble with a RocketPort/RocketModem installation, try the 
following.
Note: Most customer problems reported to Technical Support are traced to cabling 

or network problems.

Issue Troubleshooting

Correct cabling

Verify that you are using the correct types of cables in the 
correct places and that all cables are tightly connected.  
Refer to the appropriate RocketPort/RocketModem User 
Guide on the CD or download the latest version (Page 6) to 
verify cabling.

Device Manager
Verify that the RocketPort/RocketModem has installed 
using the Device Manager to confirm that the RocketPort/
RocketModem adapter displays. Install the device driver, if 
the adapter is not displayed.

Port does not open

After driver installation, open the Device Manager, go to 
Ports COM & LPT. If a yellow exclamation mark represents 
the port, right-click on the exclamation mark, and click 
Update Driver. See Updating the Driver on Page 13 for 
detailed procedures.

Port addressing
Verify that you are addressing the port correctly. In many 
applications, device names above COM9 require the prefix 
\\.\ to be recognized. For example, to reference COM20, use 
\\.\COM20 as the file or port name.

Verify the driver

Check to see if this is the latest driver. To check the driver 
version, open the Device Manager, expand Multi-port 
Serial Adapters, right-click the adapter, and select 
Properties. Click the Drivers tab and note the driver 
version and date. 
Check the latest driver version on the ftp site (Downloading 
the Latest Software and User Guides on Page 6).
If the installed driver is older, download the latest driver. 
Remove the existing driver and install the latest driver.

Test port or ports Install the Comtrol Utility (Page 38) and use Test Terminal.

Monitor port 
activity Install the Comtrol Utility (Page 38) and use Port Monitor.

Verify hardware
Run the RocketPort/RocketModem diagnostics. The adapter 
is shipped with a bootable CD that executes the hardware 
diagnostics. If necessary, you can download the diagnostics 
.iso file and burn the bootable Diagnostics CD.

Enable Verbose 
mode

Enable the Verbose Event Log feature on the Options tab in 
the  driver and then reboot the server. See Enabling Verbose 
Event Logging on Page 39 for procedures.
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Comtrol Utility (Test Terminal and Port Monitor)

Install the Comtrol Utility package, which contains Test Terminal and Port 
Monitor.
• Test Terminal can be used to troubleshoot communications on a port-by-port 

basis. Test Terminal requires a loopback plug. You can build a loopback plug 
using the appropriate RocketPort/RocketModem User Guide (Page 6).

• Port Monitor checks for errors, modem control, and status signals. In addition, 
it provides you with raw byte input and output counts.

The Comtrol Utility is available on the Software and Documentation CD or you can 
download the latest version (ftp://ftp.comtrol.com/utilities/windows/
comtrol_utility). To install the Comtrol Utility package, execute the .msi file and 
follow the installation wizard. 
Windows Vista, Windows Server 2008, and Windows 7: To run any unsigned 
application so that it functions properly, right-click on the application icon or 
shortcut, and click Run as administrator.
Use the following subsections for information and procedures to run Test Terminal 
tests.

Test Terminal 
Explanation

This subsection provides background information about the two tests procedures 
in the following subsections.
• Send and Receive Test Data: This sends data out the transmit line to the 

loopback plug, which has the transmit and receive pins connected thus 
sending the data back through the Rx line to Test Terminal, which then 
displays the received data in the terminal window for that port. This test is 
only testing the Tx and Rx signal lines and nothing else. This test works in 
either RS-232 or RS-422 modes as both modes have transmit and receive 
capability. A failure in this test essentially prevents the port from working in 
any manner.

• Loopback Test: This tests all of the modem control signals such as RTS, DTR, 
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is 
made HI in one line the corresponding signal line indicates this. The Loopback 
Test changes the state of the lines and looks for the corresponding state 
change. If it successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it depends on what is 
connected and how many signal lines are in use. For example, if you are using 
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure causes no 
discernible issue since the other signals are not being used. If the port is 
configured for use in RS-422, this test fails and is expected to fail since RS-422 
does not have the modem control signals that are present in RS-232 for which 
this test is designed.

Using Test Terminal 
to Test a Port

The following procedure shows how to use Test Terminal to send and receive test 
data to the serial ports and run a loopback test.
1. Stop all applications that may be accessing the ports such as RAS, RRAS, or 

any faxing or production software. See the appropriate help systems or 
manuals for instructions on stopping these services or applications. If another 
application is controlling the port, then Test Terminal is unable to open the port 
and an error message displays.
Note: Remember to restart the application once testing of the ports has been 

completed.
2. From the Start menu, click Programs > Comtrol > Utilities > Test Terminal 

(WCOM2).
3. Click File > Open Port and the appropriate port (or ports) from the Open Ports 

drop list.
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4. Install the loopback plug onto the port (or ports) that you want to test.
5. Click Port > Send and Receive Test Data.

You should see the alphabet scrolling across the port. If so, then the port 
installed properly and is operational. 
Note: Click Port > Send and Receive Test Data to stop the scrolling data.

6. Click Port > Loopback Test.
This is a pass fail test and takes a second or two to complete. Repeat for each 
port that needs testing.
The loopback test tests the modem control (hardware handshaking) signals. It 
only has meaning in RS-232 mode on serial connector interfaces with full RS-
232 signals. If performed under the following conditions, the test will always 
fail because full modem control signals are not present:
Note: If you experience a failure, retest that port a second time.

7. Close Test Terminal.

If both of these tests successfully complete, then the port is operational as 
expected.
Note: Do NOT forget to restart the application.
If either of these test does not complete properly, then you can try the following:
• Verify that the latest device driver is loaded.
• Run the latest bootable diagnostic.

Enabling Verbose Event Logging

You can optionally enable the 
Verbose Event Log option on the 
Options tab for diagnostic 
purposes to initiate longer 
messages to be sent to the Event 
Log for your operating system. 
The added information can be 
useful when debugging 
communications and configuration 
problems.
Access the event log through the 
Administrative Tools Event Viewer 
option.
Use the following procedure to 
enable the Verbose Event Log 
option.
1. Use the Device Manager to 

open the RocketPort/
RocketModem driver.
• Windows 7 and Windows 

Vista: Right-click 
Computer, click Manage, 
and then highlight the Device Manager.

• Windows Server 2008 R2: Click Start, right-click Computer, and then click 
Properties.

• Windows Server 2003: Right-click My Computer, click Manage, and then 
click the Device Manager button.
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• Windows XP
Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Double-click the RocketPort/RocketModem for which you want to enable the 
Verbose Event Log.

3. Click the Options tab.
4. Select the Verbose Event Log option.

Before calling Technical Support

Comtrol has a staff of support technicians available to help you. You should review 
Troubleshooting Checklist on Page 37 before calling Technical Support. If you call 
for Technical Support, please have the following information available.

Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Item Information

Adapter type

Adapter serial number

Driver part number and 
revision or version

Server computer make, 
model, and speed

Other serial port adapters 
installed in the server and 
their COM port numbers

Devices connected to the 
adapter

Contact Method Corporate Headquarters

Support http://www.comtrol.com/pub/en/Support

Downloads ftp://ftp.comtrol.com/html/default.htm

Web site http://www.comtrol.com

Phone 763. 494.4100
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Configuring Non-Plug and Play Devices 
(Windows XP and Windows Server 2003)

After installing the hardware and driver for Windows XP or Windows Server 2003, 
you can use this discussion to configure non-plug and play modem COM ports.

Installing Non-Plug and Play Devices

Use the following procedure to install non-plug and play devices.
1. If you have not so yet, connect the device to a RocketPort/RocketModem port 

and turn on the device.
2. Open the Control Panel.
3. Go to the appropriate subsection to install non-plug and play modems or 

printers:
• Installing Modems on Page 41
• Installing Printers on Page 42

Installing Modems Use the following procedure to install non-plug and play modems.
1. If you have not done so yet, connect the modem (or modems) to the desired 

RocketPort/RocketModem port (or ports) and turn on the modem (or modems).
Note: This may take a few minutes, depending upon your system and the 

number of modems you are installing.
2. Open the Control Panel and click the Phone and Modem Options icon.
3. Click the Modems tab.
4. Click Add.
5. Click Don’t detect my modem. I will select it from a list and then click Next.
6. Click an appropriate modem model and then click Next.

Note: If you have a driver from the modem manufacturer, click Have Disk and 
browse to the location of the driver. If your modem is not listed, go to the 
modem manufacturer’s web site and download the appropriate driver.

7. Highlight the port or ports on to which you have connected modems.
8. Click Finish to complete the modem installation.
9. Configure modem properties as necessary. For assistance, use the Windows 

help system.
To use this modem or modems with RRAS, you can refer to the Comtrol RRAS 
Configuration Overview for Windows XP document.
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Installing Printers Use the following procedure to install a non-plug and play printer.
Note: If you want to install a plug and play printer, connect the printer to the 

appropriate serial port and the driver should automatically install. If it 
does not automatically install, use the following procedure as a guide with 
the printer manufacturers documentation.

1. Open the Control Panel and click the Printers and Faxes icon.
2. Click Next when this screen appears.
3. Click the Local printer attached to this computer item.
4. Click the COM port that corresponds to the port to which the printer is 

connected.
5. Click the Manufacturer, Printer type, and then click Next. 

Note: If you have a driver from the printer manufacturer, click Have Disk and 
browse to the location of the driver. If your printer is not listed, go to the 
printer manufacturer’s web site and download the appropriate driver.

6. Optionally, enter a printer name and then click Next.
7. Click Yes if you want to print a test page.
8. Click Finish to complete the installation.

9. Close the Printer and Faxes control panel.
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